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Overview 

Login and Access 

Access to functions within the application is restricted based on roles. Which roles you have is determined 
by your Education Sector Login (a.k.a. ESAA) set-up, according to the roles your organisation has granted 
you. 

For a full list of roles and access rights see:  Appendix A: Access Rights 

 

Log in to the external moderation application 

1. Log in to the NZQA Schools & TEOs Login (https://www.nzqa.govt.nz/login/), using your usual 
Education Sector logon details. 

2. Select the External Moderation link from the Moderation section. 

 

 

 

 

 

 

3. The landing page of the application displays. You can now navigate to the appropriate part of the 
application. 

• NZQA Logo – click on the logo or the Home symbol to return to the landing page from anywhere 
in the application. 

• Menu Buttons – provide access to different parts of the application.  
The buttons available are dependent on your access. 

• User Profile – click here to logout.   

 

 

  

https://www.nzqa.govt.nz/login/
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Navigation 

 

The following functions are accessible from the landing page: 

Button Description 

 
View your current Assessment Plan, select standards, and submit your 
plan.  

See: Assessment Plan section for more details.  

 
View moderation plans for the current and previous (or next cycle), 
prepare moderation submissions, view reports, and submit queries and 
appeals for moderation reports. 

See:  Moderation Plan, Make a Moderation Submission, Moderation 
Reports and Appeals sections for more details.  

 

View moderation results and reports for the previous five years (from 
2017 onwards). Results prior to 2017 are available via the Historical 
moderation link 

See: Moderation History section for more details. 

 

View the current annual summary, any related action plan, and access 
historical summaries. 

See: Annual Summary section for more details 

 

Training materials and guides for the External Moderation application. 

 

Notifications  

 

The application will notify you of outcomes or of tasks you need to complete. For example, you will receive 
an email when your assessment plan is ready to access, or a reminder to submit materials for moderation. 

Only the person recorded with NZQA as the moderation contact will receive notifications from the External 
Moderation Application, i.e.: 

• Schools: Principal’s Nominee 

• TEOs: Moderation Liaison 

Notifications will be sent to the email address held by NZQA for the moderation contact. If you want us to 
send the notifications to a different email address, you’ll need to update your preferred email address in 
NZQA’s School &TEO Login. 

This information may take up to 48 hours to update the application. 

 

Note: The person preparing a submission can enter their email address to receive a notification when the 

moderation report is available - see no.8 p.24 
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Common Features  

Tables 

 

Wherever information is presented in a tabular form in the application there is a common set of features. 

These features are available on the following pages: 

• Assessment Plan 

• Moderation Plan 

• Moderation History 

TABLE OPTIONS 

The options available on the table views are: 

Some options may not be available on some tables. 

Menu Item  Description 

Actions Menu Drop-down to access actions specific to the External Moderation application.  

E.g.: Submit Standard, View Report. Action menu is also accessible by ‘right-clicking’ 
on a selected standard. 

Available on the Moderation Plan and Moderation History pages.   

View Menu Drop-down list of actions which can be used to customise the table view. 

 

Export the data displayed in the table as an excel file. 

 

Export the data displayed in the table in .csv format. 

 

Creates a printable view of the current screen. Use your browser print option (or Ctrl-
P) to print the view. Only prints what is visible on the view.  

Refresh:  

Clears any duplicate columns (sometimes occurs when manually re-ordering). 

DO NOT use refresh on a ‘detached’ window – the application will freeze.  

Filter:   

Filter the data in the view. 

 

Opens the current view ‘full screen’ in a separate window. All options (except Refresh) 
are available in the detached view. 

Expand:  >> Under some circumstances the menu may shrink and not all icons are visible. Click on 
the expand icon (>>) to access them. 
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FILTER TABLES 

Use the Filter option to quickly find an item of interest e.g. a standard. 

 

Apply a Filter 

1. Enter the filter criteria in the field above the column you want to filter on. 

2. Press Enter, (on your keyboard) to apply the filter. 

3. Example: filter Assessment Plan by Standard Title: 

To find … Then… 

a specific standard Enter the full standard number in the Standard Number field. 

a range of standards If the standards begin with the same series of numbers, type the common 
numbers followed by an asterisk in the Standard Number filter field. 

Example: 9084* will display standards: 90840, 90841, 90842, etc 

standards that 
contain a specific 
word 

Enter the word in the Standard Title filter field, or  

Use wildcards to find ‘like’ words: e.g. *market in the Title field will display any 
standards that contain words like market, markets, marketing, supermarket. 

all standards for a 
level  

Enter the level number in the Level filter field. 

all ‘selected’ 
standards 

Enter ‘T’ in the Selection filter field (Assessment Plan only). 

  

 

Remove a Filter 

A filter, will apply until you change or remove it, even if you open another system. 

To remove the filter – just delete the text entered in the filter field(s) and press Enter key. 

 

  



 EMA Guide for Schools and TEOs 

 

29-Aug-2018            Page 8 of 47 

EXPORT DATA FROM A TABLE 

You can export any data that is displayed in a table in the application.  

The export is dependent on what view you are in, i.e.: 

• Assessment Plan:  

o Summary table - the list of systems, and number of standards selected. 

o By ‘Select Standards’ – all standards on the plan. 

o By System – all standards for that system. 

• Moderation Plan – all standards on the plan. 

• Moderation History – historical outcomes for completed reports (2017 onwards). 

 

If you have customised your view, then the exported data will reflect that customisation. 

Data can be exported in Excel (.xls) or CSV formats. 

 

Export to Excel  

 
To export a plan to Excel: 

1. Select the Excel icon. 

2. A confirmation pop-up will display 

Note: the pop-up does not always come to the 
front of the screen – if it doesn’t you can find it by 
tabbing through your open windows (Alt-Tab, on 
the keyboard). 

3. Choose the ‘Open with’ option. 

4. Check the application is set to Excel – or select it 
from the drop-down. 

5. Select Ok to confirm. 

6. Excel will start (if not already open) and a 
warning message may appear – select Yes to continue. 

 

7. Excel will open with the exported data in the worksheet. 
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Export to CSV  

 
Use this format if your spreadsheet application is not 
Excel. 
 
To export the plan in CSV format.  

1. Select the CSV icon. 

 

2. A confirmation pop-up will display: 

 

3. Choose the ‘Save File’ option and select OK to 
confirm. 

4. Open the file from your saved downloads (the 
location is dependent on the browser you use). 
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VIEW TABLE IN FULL SCREEN 

 

Detached View 

Detach the table to view in ‘full screen’. 

 

To return to the main 
view click on the X. 

 
 
 
 
 
 
 
 

Detaching the table does not increase the number of rows visible – you will still need to use the page 
navigation if you have more than 15 standards on your plan. 

 

 

Notes 

• All the table options are available in the detached view.  

• DO NOT ‘refresh’ a detached table – it will cause the screen to freeze. 
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CUSTOMIZE A TABLE 

You can customise your view of the Assessment or Moderation plan, or Moderation History view including: 

• which columns to display 

• the order of the columns 

• the sort order. 

Any changes you make will be saved when you exit the application. The changes are specific to your view 

and do not affect any other users. 

 

Example: Moderation Plan View 

You may find it helpful to tailor the moderation plan view according to where you are in the moderation 
cycle:  

 

 

 

Choose which columns to display 

To choose which columns to display: 

1. Select View > Columns from the menu. 

2. Tick or un-tick column names, as 
required. 

3. Only ticked columns will display. 

 

Note: the columns available will depend on 
the view. This example is for the Moderation 
Plan. 
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Change column order 

 
To change the order of the columns: 

1. Select View > Reorder Columns from the menu. 

2. Select the column name for the column you want to move. 

3. Use the arrow keys to change the order of the selected column. 

4. Repeat for any other columns. 

5. Select OK to save the new order. 

 

Notes:  

• Only columns selected to display (see above) will be listed in the Reorder Columns pop-up’ 

• The columns available will also depend on the view. This example is for the Moderation Plan. 

• You can also reorder using the column headings (drag & drop). The table will revert to the default 
order next time you log in. 
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Custom Sort the table 

To create a custom sort order for the rows in the table: 

1. Select View > Sort from the menu. 

 

2. Select the column title in the drop-down and the order (ascending or descending). 

3. Add additional sorting levels as required. 

4. Select OK to save the order. 

 
Notes: 
• You can also sort using the column headings. The table will revert to the default order next time you 

log in. 
 
Example: Moderation Plan sorted by: System > Level > Standard Number 
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Download and Print 

Moderation Reports and Annual Summaries can be downloaded for printing or electronic distribution.  

 

Reports can be downloaded from the following pages: 

• Moderation Report view 

• Moderation Plan table 

• Moderation History table.  

Any person with access to the application can download/print a report. 

 

Annual Summaries can be downloaded from the Annual Summary view. Only people with access to view 

Annual summaries can download/print them. 

PRINT 

 

Print a single moderation report 

1. Log in to the application and select 
Moderation. 

 

2. Click on the required standard.  

 

3. Right-click to access the menu. 

 

4. Select Print Report from the menu. 

 

Print multiple moderation reports 

1. Log in to the application and select Moderation History.  

2. Ctrl-click to select multiple standards from the table:  

• You can select up to 75 standards. 

• The reports will be generated as individual pdfs within a single zip file. 

3. Right-click on a selected standard to access the menu. 

4. Select Print Report(s) from 
the menu. 

 

Note: the download time is 
dependent on the number and 
size of the reports selected. 
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To print an annual summary 

1. Log in to the application and 
select Annual Summaries  

 

2. Select and View the required 
summary.  

 

3. Select Print/Download. 

DOWNLOAD FILES 

 

Filenames  

The print function creates a download file of the selected document(s) with the following naming 
conventions: 

• Single report:  Moderation Subject Name – Standard Number – Year (.pdf) 

• Multiple reports: 

o creates a single zip file for ALL the selected reports: Reports – File Created Date – Year (.zip) 

o individual reports within the zip file: Moderation Subject Name – Standard Number – Year (.pdf) 

• Annual Summary: Year – Summary – School Number (.pdf) 

 

Open Download Files 

When the downloadable file is created the result will 
depend on your browser and personal set-up:  

• a pop-up may open with options to save or open 
the file  

 

• the downloaded file link may appear somewhere 
on the screen 

 

• the file will also be accessible from your browser 
download menu and/or the ‘downloads’ folder 
on your device.  
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Assessment Plan 

Overview 

An assessment plan for the next moderation cycle is released by early November each year.  

You will receive an email notification when your plan is available, and a reminder to submit your plan prior 
to the due date. Plans are due early December. 

TEOs  

Must select all the standards they are intending to assess and provide the earliest date that the learner 
evidence will be available for moderation for each standard. TEOs are required to submit an assessment 
plan if they have consent for NZQA managed standards. 

Schools 

Selection of standards and submission of a plan is optional for schools but provides a way to communicate 

your preferences for moderation to NZQA. If you have no preference on what standards are moderated 

within a system, then no selection is required for that system.  

Where possible, NZQA will include standards selected by the school. However, other considerations 

sometimes mean this is not possible. 

Note: Materials Available Date – schools may use this date for your own planning purposes, but the work 

must be available for your agreed submission date. 

 

Quick Steps  

1. Log in to the application and select Assessment Plan. 

2. Select the relevant moderation system. 

3. Select the relevant standards from the system . 

4. Enter the Date Materials Available for each selected standard, if required. 

5. Save the selected standards in the system. 

6. Repeat for all relevant systems. 

7. Enter a comment (optional). 

8. Select Submit Plan to submit to NZQA. 

 

Common Features  

You can modify the Assessment Plan tables and customise them to your personal requirements.  

See the following sections under Common Features:  

• Table Options: explains the available menu options. 

• Customize a Table: for how to add/remove columns, change the default sort order. 

• Export Data from a Table: for how to export the data in the plan. 
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Complete and Submit a Plan 

Role required:  

Moderation Processor (General Security User) can complete standard choices and save notes in the 

comment box. 

Moderation Authoriser (High Security User) to submit the assessment plan 

 

To complete and submit an assessment plan  

1. Log in to the application and select Assessment Plan. 

2. Select the Yes radio button, if you are assessing NZQA standards in the next year. 

3. To select standards, either:  

• Choose the Select Standards link (to view all standards), or 

• Select the link to an individual system from the summary table. 

4. Select individual standards, as required (see the Select Standards section of this guide) for all 
relevant systems.  

5. As you save your selections the Summary table updates with the: 

• number of standards selected within the system 

• ‘latest’ materials available date, if entered for standards. 
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Complete and submit an assessment plan, continued  

6. Add a comment (optional)  

The comment will be visible to the NZQA staff member responsible for confirming your organisation’s 
moderation plan. The comment field takes a maximum of 250 characters. 

Note: Comments can be added to the comment field by all users.  
Enter your comment and select the Save button below the comment field. 
Schools: Use the comment box to suggest standards that you cannot select in your assessment plan. 

7. Select Submit Plan, when all standards are selected, and the plan is ready to submit. 

 

8. A warning message will display, select Yes to submit the plan to NZQA. 

-  Following submission (or the due date for school plans) the plan will be locked (read only). 

 

 

Submit a Nil Assessment Plan  

 

TEOs who are not assessing any NZQA managed standards in the upcoming year should submit a Nil 

plan. 

Submit a Nil assessment plan (TEOs only) 

1. Log in to the application and select Assessment Plan. 

2. Select the No radio button, if you are NOT assessing NZQA standards in the next year. 

3. Add a comment (optional). The comment will be visible to the NZQA staff member responsible for 
confirming your organisation’s moderation plan. The comments field takes a maximum of 250 
characters. 

4. Select Submit Nil Plan, if the plan is ready to submit. 

5. A confirmation message will appear - select Yes to submit the Nil plan to NZQA. 

- Following submission, the plan will be locked (read only). 
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Selecting standards 

Role required: Moderation Processor (General Security User), Moderation Authoriser (High Security User) 

 

To select standards  

1. Select the standard (tick) - Selection checkbox. 

2. Add the Date Materials Available (optional for schools): 

• choose the date from the calendar 

• or, enter the date in the format: dd/mm/yyyy. 

Note: schools may use this date for your own planning purposes, but the work must be available for your 
agreed submission date. 

3. Continue selecting standards for this system, as appropriate.  

4. Save your selections using:  

• Save - to save without closing the window.  

• Save and Exit - to save and return to the plan overview.  

 

Note: System Name 

The NZQA Moderation System name that appears at the top of the list, on the Select Standards window, 
defaults to that for the first standard on the list.  So, if you open a: 

• System - then it is the system name  

• all standards (i.e. use the Select Standards link) – it displays the system for the first standard in the 
list and may change if the standards are re-ordered or filtered. 
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Finding a specific standard 

Use the Search function to quickly find an individual standard or all standards in a system. 

 

Search for a standard 

1.  Use the Select Standards link (for all standards) or open an individual system: 

Note: You can also search for a standard by opening any of the systems in the Summary panel. 

2. Click the search icon  beside:  

• System name – to search for all the standards within a moderation system. 

• Standard – to search for a specific standard 

3. Search for the standards. 

To search 
for… 

Then… 

All standards 
within a system 

• Type the first few letters of the name of the moderation system. 

• Select Search. 

• Select the required system from the result list. 

• Click OK to return to the main search screen. 

A specific 
standard 

• Type the exact standard number, then Search.  

• Select the standard, then OK to return to the main search screen. 
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Search for a standard 

Advanced 
Search 

• Use the advanced search feature to find a system when you are unsure of the 
name: 

• e.g. ‘Contains: Design’, returns: 

- Graphics and Design Technology 

- Technology – Design and Visual Communication 

4. The Select Standard page updates with all the standards that match the search criteria.  

• Example: Search for standard: 91080 

 

Submitted Plans  

 

Once the plan has been submitted it will be locked (read-only). If you require changes to your plan after you 

have submitted it please contact your School Relationship Manager or Moderation Support person. 

 

Locked Plans 

A plan will be locked when: 

• it is submitted by the school or TEO 

• the plan submission date is passed (schools only). 

The message is updated when: 

• the moderation plan is available, or 

• an exemption, or Nil plan status is confirmed for a TEO. 

 

Example: 
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Moderation Plan  

Overview 

 

The Moderation Plan will become available when NZQA has selected the standards for moderation. The 

timing may vary according to the type of provider and your moderation submission date. 

 

View Previous/ Next Plan 

At certain times of the year, and depending on your submission date, you may have two moderation 
plans available. 

Use the year drop-down to change between plans. 

 

Show/hide explanatory text 

The explanatory text at the top of the page can be hidden to increase the visible area of the screen. The 
expand/contact icon is located beside your organisation name.  

Text section hidden - click to expand.    

 

Text section expanded – click to hide. 

 

 

Common Features  

You can modify the Moderation Plan table and customise it to your personal requirements.  

See the following sections under Common Features:  

• Table Options: explains the available menu options 

• Customize a Table: for how to add/remove columns, change the default column and sort order 

• Export Data from a Table: for how to export the data in the plan 
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Make a Moderation Submission 

 

Quick Steps  

1. Log in to the application and select Moderation. 

2. Select the required standard. 

3. Complete the Submission Details and Assessment Task sections. 

• For a digital submission: 

o Enter a link (URL, username and password (if required for the moderator to access the 
materials), OR 

o Upload digital materials for the task. 

4. Save the submission. 

5. Add Learners: enter a grade for each learner, and comments as appropriate. 

• For a digital submission: 

o upload digital materials (if not submitting by URL, as above) 

6. Save, and update status to Ready to Submit. 

7. Submit the standard to NZQA for moderation (authorisers only). 

8. If you selected Physical submission you should receive an email containing the moderator’s address 
within 5 working days. Forward the materials to the moderator as soon as possible. 

 

CREATE A SUBMISSION FOR A STANDARD 

Role required: Moderation Processer or Moderation Authoriser (High Security User) 

 

To create a submission for a standard 

1. Log in to the application and select Moderation. 

2. CHECK you have the correct plan year selected.  

• Change the year in the Select Moderation Plan Year 
field, if required.  

3. Select the relevant standard. 

4. Open the Actions menu (from the menu or ‘right-click’ on the selected standard) and select Edit 
Submission. 
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Create a submission for a standard, continued 

5. Complete the Submission Details section:  

• Submission Type  

− Digital - if submitting materials on-line  

− Physical - if submitting materials by courier.  

• Language 

− English - default 

− Te Reo Māori or ‘Other’ – choose the appropriate 

value. 

• Version 

− defaults to the latest version of the standard, 
update if a different version was assessed. 

 

6. Complete the Assessment Materials section: 

• Source   

− the source of the assessment task.  

• Modified 

− Yes - if the assessment task was modified (other 
than context) before use. 

− No - if the assessment task was unmodified 
(other than context). 

 

7. If making a digital submission, either: 

• Enter a cloud storage link  

• Include a username and password, if needed for the moderator to access the files. 

Or  

• Attach the assessment task files to the submission, in the Activity section: 

− Select Browse  

− Find the file you want to upload, select it then click Open. 

− Repeat as required. 

8. Contact – additional to main/authoriser contact - optional 
Enter an additional email address to also receive notification when the moderation report is available. 
The Principal’s Nominee in a school and Tertiary Moderation Liaison people are notified 
automatically. 

 

See: Moderation Submission Tips and Appendix D: File Management & Digital Submissions for 
additional information on making digital submissions. 
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Enter learner grades and upload materials  

Role required: Moderation Processer or Moderation Authoriser (High Security User) 

 

 To enter learner grades and upload materials 

Notes:  

• Complete the Submission Details and Assessment Task sections (above), before adding 
learners. 

• Enter a learner grade for ALL learners that you are submitting evidence for. 

1. Select Add Learner. 

2. Enter the details for the learner. 

• Learner Identifier – an identifier is 
automatically assigned (Learner A-H).  

• Label any physical materials being submitted 
with the matching identifier. 

• Grade – select the learner’s grade from the 
list of values (mandatory). 

• Comment – an optional comment on the 
grade awarded, or to note if evidence applies 
to more than one learner.  

• Group work identifier – use this option to 
identify an individual in a group work. Use a 
description (red shirt) not the learner’s name. 

3. If this is a digital submission and you have not 
included a link, then attach the learner evidence:  

• Select Browse... 

• Find the file you want to upload, select it then 
click Open. 

• Repeat as required. 

4. To add more learners, click the Add next button, 
and repeat steps 2 & 3.  

5. Select Save and Exit, when all learner grades 
are added. 

• As each learner is added the summary table 
(on the Edit Submission window) is updated.  

• From the summary table, you can: 

− view the attached evidence  

− open and edit the learner record,  

− delete the entire record. 

6. When the standard is ready for submission select 
Ready to Submit. 

• The status of the standard is now ‘Submission 
- Ready to Submit’ 

• The standard remains editable until it is 
submitted. 

7. At any stage or preparing a submission it can be cancelled before submitting to NZQA by selecting 
Cancel Submission. This will set the status of the standard back to Submission – Not Started. 
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Submit one or more standards to NZQA 

Role required: Moderation Authoriser (High Security User). 

 

To submit a standard for moderation 

1. Log in to the application and select Moderation. 

2. Review standards where the status is ‘Submission - Ready to Submit’.  

Check:  

• The Submission Details and Assessment Task sections are complete. 

• A learner grade is entered for ALL learners that you are submitting evidence for. 

• Digital submissions only:  

o A Link (URL) is included with a username and password if required,  

OR  

o At least one document/file is uploaded for the Assessment task and each Student. 

 

3. Submit the standard(s) for moderation. 

• For one standard:   

o Select the standard and open the action menu (right-click). 

o Select Submit.  

o Displays a confirmation message 
for the standard:  

o Select Yes. 

 

• For multiple standards:   

o Note: this action submits ALL standards with status ‘Ready to Submit’ 

o Select a standard and open the action menu (right-click). 

o Select Submit All.  

o Displays a confirmation message 
for the standards:  

o Select Yes. 

 
Result: 

• The standards are submitted to NZQA for moderation. 

• The status of the submitted standards changes to ‘Submission – Submitted’ 

• The submitted standards are no longer editable. 

 

See: Moderation Submission Tips for how to: 

• Respond to submission error messages. 
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Submission Tips 

 

Deleting an attached document 

If you’ve uploaded the wrong document for a: 

Task: 

• Select Delete documents to open the Delete 
window.  

• Select Delete  to delete the file.  

 

Learner: 

• Select Edit  for the relevant learner on the 
summary table. 

• Select Delete documents to open the Delete 
window.  

• Select Delete  to delete the file.  

 

Submitting a link 

 
Files stored in a cloud storage system (e.g. Google Drive, SharePoint) can easily be submitted by 
providing a share link or URL. 
 
Ensure that: 

• the files relevant to the standard are organised so that the assessment task and work for each of the 
students is readily identifiable by the moderator.  

• the share rights are set so the moderator can directly access the materials. For example:  

o Google Drive set to “Anyone with the link”. 

Note: Files are secure behind both the organisation user login and the moderator login. 
 

1. Enter the link/URL into the Link field in the Submission Details section 

2. Ensure a username and password are included, if needed to access the files.  

 

3. Ensure grades are entered in the application for ALL students.  If a grade is not entered via the 
application the moderation result cannot be recorded for that student. 
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Removing access to materials 

NZQA access to the materials is required if you wish to query or appeal the report. 

Once the moderation is complete and the report becomes final, access to the materials can be removed. 

 

Submission Error Messages  

The following are common validation error messages that occur when making a moderation submission, 
and what to do about them: 

Message Action 

At least one learner must be 
created. Please try again. 

Add Learner to create a learner record. Ensure you create a 
record for ALL the learners you are submitting evidence for. 

See: Enter learner grades and upload materials  

For digital submission 

You must enter a url OR upload 
files for assessment task and 
learner evidence before submitting 
this standard 

Check there is either: 

- a link (URL) entered in the Link field 

OR 

- a valid file uploaded for:  

o the assessment task 

o at least one learner. 

Ensure you create a record and enter a grade for ALL the 
learners you are submitting evidence for. 

Standard (number) not ready to 
submit. Please enter results before 
submitting. 

Check there is at least one learner record created for the 
submission. 

Check the status is ‘Submission - Ready to Submit’. 
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Moderation Reports 

Moderation Report Dates and Statuses  

 

The following table provides information on how the status and report due date change according to the 

progress of the submission and report. 

 

When the … Status changes to … 

PN/Mod Liaison submits online. Submission - Submitted 

moderator requests physical materials. Report – Pending Material 

moderator accepts the submission (digital submission OK, or physical 
materials received). 

Report - In Progress 

moderator completes the report. Report - Provisional 

provisional period expires and no appeal has been received. Report - Final 

appeal is accepted. Appeal – In progress 

appeal is completed. Report - Final (Appeal) 

 

 

Quick Steps – View, Print and Query 

1. Log in to the application and select Moderation. 

2. Select the required standard: 

• The status must be Report- Provisional, Report-Final or Report-Final (Appeal) 

3. Right-click on the selected standard. 

4. Select the required menu option to view or print the report. 

5. To query a report (Moderation Plan only):  

• Select View Report, then Query Report. 

• Enter your query and Submit. 
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View a Moderation Report  

There are two options for viewing a report.  

• Recently published reports (provisional) and final reports for the current and previous year can be 
viewed from the Moderation Plan page.  

• All final reports including reports more than two years old can be viewed from the Moderation 
History page. 

Only reports in the following statuses can be viewed: 

• Report-Provisional 

• Report-Final 

• Report-Final (Appeal) 

Once final, reports will remain available indefinitely.  

 

View a moderation report – Moderation Plan View 

Role required: any person with access to the application can view reports. 

1. Log in to the application and select Moderation  

2. Select (click) on the required standard, then right-click to access the menu. 

3. Select View Report from the menu. 

o The overview section of the report is displayed 
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View a moderation report, continued 

4. Drill down to each section, as required.  

• Assessor Decisions: The outcome 
of the moderation. To see the learner 
grades, select View Details. 

• Assessment Task: The outcome for 
the assessment task, if moderated. 
To see the detail of any issues and 
recommendations, select View 
Details. 

• Issues: This section only displays if 
one or more issues were identified 
during moderation. 

• Query: This section only displays if 
your organisation has sent in a query 
about this moderation report. To see 
query details, select View Details.  

• Appeal: This section only displays if 
your organisation has appealed this 
moderation report.  
In this example, no appeal has been 
created. 

5. Select Download Report to generate a 
printable version of the report. 

6. Select Cancel to close the report. 

 

View Learner Details 

The assessor and moderator’s grades for the learners 
are displayed in a summary table. To view the details 
for a specific learner:  

• Click the View Comments (      )  icon for that 
learner. 

• View the Evidence that was uploaded for the 
learner (digital submissions only). 

• View assessor and moderator grades and 
comments. 

 

Use the <Prev and Next> buttons to move through the 
list of learners. 
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Query a Moderation Report  

Use a Query where you’re not clear on the meaning of something in the moderation report, to clarify the 
decisions and comments following moderation.  

You can only submit a query if the status of the report is ‘Report-Provisional’. 

 

Role required: Moderation Processer or Moderation Authoriser (High Security User) 

 

To query a moderation report 

1. View the report as above. 

2. Select Query report. 

3. Type your question in the Query field. 

4. Upload any relevant evidence using the 
Choose File function.  

▪ Note: Only evidence from the original 
submission should be included. 

5. Save or submit your query: 

• Save to save your query without 
submitting it. 

• Cancel to return to the report, without 
saving the query. 

• Submit, then click Yes to send the 
query to NZQA. 

 

Notes 

 

Submitting a query doesn’t change the status of the standard 
in the moderation plan. The only difference is that a Query 
section gets added to the report. 

 

The Principals’ Nominee or Moderation Liaison will receive an 
email notification when the moderator responds to the query. 

 

To view a query, click the View Details link on the moderation 
report, then view the questions and responses.  
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Feedback on moderation reports 

 

When you view a provisional moderation report 

there is a Feedback option. 
 

This is intended as an opportunity to provide NZQA with feedback 

regarding the detail, clarity, and helpfulness of the moderation report.  
 

Selecting Feedback will open a pop-up window in which you can 

select your responses from the drop-down menu alongside each 

question. 
 

Select Submit to save your responses and close the window. 

 

 

 

Appeals 

Appeal a Moderation Report  

 

An appeal may be appropriate if you disagree with moderation decisions and/or comments. Before creating 
an appeal, you should discuss it with the Principals’ Nominee or Moderation Liaison for your organisation. 

If you just want more information or clarification about something in the report, then submitting a query may 
be more appropriate. 

Note: An appeal must be submitted within 30 working days of the ‘provisional’ moderation report being 

published. After this time, the report becomes final. 

 

Quick Steps  

1. Log in to the application and select Moderation. 

2. Select the required standard. 

• The status must be: Report – Provisional. 

3. Right-click on the standard. 

4. Select View Report from the menu. 

5. Select Appeal report.  

6. Enter appeal details and attach evidence (if relevant). 

7. Select Ready to Submit. 

8. Submit the appeal (Management Authoriser only). 

 

Note: an appeal can only be submitted from the Appeal view, it cannot be submitted from the moderation 
plan.  
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Prepare Appeal  

Role required: Moderation Processer or Moderation Authoriser (High Security User) 

 

To prepare an appeal 

Only reports in the following status can be appealed: 

• Report-Provisional 

1. Select View Report for the relevant 
standard from the moderation plan. 

 

2. Select Appeal report. 

 

 

 

 

 

 

 

 

 

3. Select Add Issue.  
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Prepare an appeal, continued 

4. For each issue, include: 

• Description: the issue you’ve identified within the report (up to 1000 characters) 

• Material reference: location of the evidence to support the appeal within the assessment materials 
(up to 250 characters) 

• Action requested:  what outcome you are seeking (up to 250 characters).  

• Save the issue. 

 

5. Create additional issues, as required, (maximum of four), click the Add next button, and return to 
step 3. 

 

6. Evidence required for an appeal will depend on how the original evidence was submitted. 

If the original evidence 
was… 

Then… 

uploaded files the appeal moderator will have access to it, it does not need to be re-
loaded. 

a link (URL) please ensure the link (and any associated username and password) are 
still active so the appeal moderator will have access to the evidence. 

physical and the material 

has been returned 
You may choose to submit the evidence digitally (see below) or you will 
need to return the evidence to NZQA. 

physical and the material 

has not ben returned 
Submit the appeal and note that the material is still with the moderator 

 

Note: If the original moderation submission was a physical submission, you can upload digital files of 
the material to expedite the appeal process.  

• Select Attach Evidence. 

− In either the Assessment Task or Learner Evidence sections, select the Browse button. 

− Find the file you want to upload, select it then select Open.  

− Repeat as required and Save. 

Only material orignially submitted for moderation should be included with an appeal. Any 
additional material will not be considered for the appeal. 

 

7. Once you have added all the issues and evidence, select Ready to Submit. 

• You can still edit an appeal with status ‘Ready to Submit’.  
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Submit Appeal 

Role required:  Moderation Authoriser (High Security User) 

 

To submit an appeal to NZQA 

1. Select View Report for the relevant standard on the moderation plan. 

Note: the status should be ‘Appeal Ready to Submit’ 

 

2. Select Appeal Report.  

 

3. Review the appeal details. Ensure that: 

• the issue Description and Action Requested sections contain sufficient detail 

• only originally submitted material is 
included. Any additional material 
will not be considered for the 
appeal. 

 

4. Save any updated details, as required. 

 

5. Select Submit.  

• A confirmation message showing 
the standard number displays. 

 

6. Select Yes to submit the appeal to 
NZQA.  

• The status of the standard changes 
to ‘Appeal submitted’. 

•  Once you submit an appeal, you 
will no longer be able to edit it. 

 

What Next? 

When the appeal is received, NZQA checks that it meets the appeal criteria: 

• If it doesn’t, you will receive a notification that the appeal was declined with the reason why. 

• If it does, NZQA will start processing the appeal. 

The appeal outcome is recorded in the moderation report. 

The Principals’ Nominee or Moderation Liaison is notified when the final report is available. 
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Annual Summary  

Overview 

 

The annual summary provides an organisational level outcome for National External Moderation of NZQA 

managed standards. 

 

Quick Steps 

1. Log in to the application and select Annual Summaries. 

2. Select the required summary. 

3. View online or download and print the summary report. 

4. Click the Moderation History link to access the moderation report historical view.  

 

View an Annual Summary 

 

Role required: only users with Moderation Authoriser or Moderation Management View can view the 

Annual Summary reports. 

 

To view an annual summary 

1. Log in to the application and select Annual Summaries  

2. Select the required summary from the list and select the View link  

Note: To view any documents associated with the summary, such as an action plan, select the 
Attachments icon. 

3. View the selected summary. 

4. Click on the Moderation History link to access the final reports view. 

5. Select Download for a printable version of the annual summary. 
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Moderation History 

Overview 

 

All final reports are available from the Moderation History page, including those for the current and all 

previous moderation cycles. 

 

You can select and download multiple reports from the Moderation History page. 

 

Common Features 

You can modify the Moderation History table and customise it to your personal requirements.  

See the following sections under Common Features:  

- Table Options: explains the available menu options 

- Customize a Table: for how to add/remove columns, change the default column and sort order 

- Export Data from a Table: for how to export the data in the plan 

 

View Historical Moderation Reports  

Role required: any person with access to the application can view historical reports. 

 

View Moderation History  

1. Log in to the application and select Moderation History. 

You can: 

• open an individual report to view it, or download single or multiple reports for printing, see: 
Download and Print section. 

• add ‘Issues’ columns to this view (see: Customize a Table), to easily see any issues raised in the 
report.. 
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Moderation Report – History View 

The report view differs slightly from the view available from the Moderation Plan page, however the content 
is identical.  Collapsed sections can be expanded by clicking the section header. 
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Appendix A: Access Rights 

Manage User Access 

If you need to arrange access to the moderation application for staff, please follow the normal procedure 
within your organisation for an Education Sector Logon. (ESL)  

An email address is mandatory and must be unique to the user (not shared by any other person who will 
also login via ESL). This email is used for verifying identity, not for sending notifications. 

 

The following roles are available for users of the external moderation application. 

Secondary MoE 
role 

Tertiary MoE role Type of access to the moderation application 

General Security 
User 

TEO View Only Users have the role of Moderation Viewer, and can: 

- view the moderation plan,  

- view moderation reports and results. 

Moderation 
Process 

TEO Administration Users have the role of Moderation Processor, and can: 

- enter assessment judgements/grades  

- upload material for moderation 

- view moderation reports and results 

- submit queries about moderation reports. 

High Security User TEO Management 
Authoriser 

Users have the role of Moderation Authoriser, and can: 

- select standards and submit assessment plans  

- view moderation plans 

- enter assessment judgements/grades  

- upload material for moderation 

- authorise moderation submissions 

- view moderation reports and results  

- submit queries about moderation reports 

- lodge appeals 

- view annual summaries and manage action plans. 

Moderation 
Management View 
Only 

TEO Management 
View Only 

Users have the role of Moderation Management Viewer, 
and can: 

- view moderation reports and results 

- view annual summaries and action plans. 

 

  

http://services.education.govt.nz/education-sector-logon
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For TEOs:  

The access required is on the following section of the ESL form: 
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Appendix B: Browsers 

Supported Browsers 

 

The following browsers are supported by the application: 
• Google Chrome 45+ 
• Mozilla Firefox 31+ 
• Internet Explorer 11.* 
• Safari 8.* 

The NZQA External Moderation application is supported across a range of browsers, however not all 
browsers behave in the same way, and functionality changes over time.  If you are experiencing issues with 
the application using a particular browser, please try a different one. We have found Mozilla Firefox 
provides the best experience when using the application. 

If you are using any browser other than those listed, then we cannot guarantee the application will work 

correctly.  

 

Incognito Mode  

Browsers offer the option of an ‘incognito’ mode where some of the information, such as cookies, that 
can cause application issues is not saved between sessions. 

You can access incognito mode in: 

• Chrome: from the Customize menu > New incognito window (Ctrl+Shift+N) 

• Firefox: from the Open menu > New Private Window 

• IE: from the Tools menu > Safety > InPrivate Browsing (Ctrl+Shift+P) 

• Safari: from the File menu > New Private Window (Command-Shift-N) 

 

CLEAR BROWSER HISTORY 

It may be necessary to clear your browser history (a.k.a. clearing the cache) if you have encountered an 
Oracle error or are having persistent issues with ‘weird behaviour’ in the application. (See: Appendix C: 
Oracle Errors). 
 
It is possible with most supported browsers to clear your history without clearing saved passwords, etc. 
 
Always shut down the External Moderation Application before clearing your history. 
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Clear browser history - Chrome  

1. Select the Customise and control Google Chrome 
icon at the top of the browser window. 

 

2. Select History from the dropdown list (or Ctrl + H). 

 

3. Select Clear browsing data. 

• A new popup displays with a list of the items to 
clear.  

 
4. Select: “All time” option, or the period required to get back to 

before you first experienced issues with the app.  
 

5. Check: 

• Browsing History 

• Cookies and other site data 

• Cached images and files 

 

6. Select Clear data. 

7. Close the browser, re-open and try again. 

 

Note:  Always clear the history if you encounter an Oracle Internal error using Google Chrome. 

 

Clear browser history - Firefox  

1. Click the Open menu icon at the top of the browser window.  

2. Depending on the options you have in your browser version, you can either: 

• Select: Options. A new tab displays. You may need to click the Privacy 
tab to display the options for clearing your history. Select Clear your 
recent history. 

• Select: History > Clear recent history from the dropdown list. 

3. Enter a time range: “Everything” or the period required to get back to before 
you first experienced issues with the app.  

4. Check:  

• Cookies  

• Cache 

• Hosted app data 

5. Select Clear Now. 

6. Close the browser, re-open and try again. 

Note: It’s usually Ok just to close the browser if using Firefox and start again. Clear the history if the error 
persists. 

Clear browser history - Internet Explorer (IE) 
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1. Select Tools > Internet 
options , at the top of the browser 
window 

2. Under Browsing history select 
Delete…. 

3. Check: 

• Temporary Internet files and 
website files 

• Cookies and website data. 

4. Select Delete. 

5. Close the browser, re-open and try 
again. 

 

Notes: 

• Always clear the history if you encounter an Oracle Error while using Internet Explorer. 

• If you select the option to ‘Delete history on exit’ then the cache will automatically be cleared 
every-time you close the browser. 

 

Clear browser history – Safari  

1. Enable the Develop menu: 

- Choose: Preferences > Advanced  

- Check: ‘Show Develop menu in menu bar’  

- Close out of Preferences. 

2. From the Develop menu select ‘Empty Caches’.  
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 Appendix C: Oracle Errors 

BROWSER ‘BACK’ BUTTON 

Many of the issues schools/TEOs have experienced with the NZQA External Moderation application result 

from using the browser back button to exit a screen. 

 

PLEASE DO NOT use the browser ‘Back’ button (or other browser navigation) to exit a screen in the 

application – always use the applications’ navigation (e.g. NZQA Logo or Home symbol) or button options 

(i.e.Exit, Cancel). 

 

Using the browser Back button is the main cause of the ‘Oracle Internal Error’ and other unfriendly screen 

behaviour such as: 

• duplicated columns in tables 

• multiple banners  

• ‘missing’ fields in Edit screens. 

 

If any of the above occur you can: 

• Use the Refresh function to restore a table with duplicated columns,  

Or: 

• Exit the External Moderation application. 

• Delete the browser cache, cookies, and history. 

• Close the browser completely (all tabs) and re-open. 

• Login again to continue working. 
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Appendix D: File Management & Digital Submissions 

MANAGING FILES STORED IN THE CLOUD OR ON YOUTUBE 

 

To submit files stored in the Cloud 

Files stored in a cloud storage system (e.g. Google Drive, SharePoint) can easily be submitted by 
providing a share link or URL. 

Ensure that: 

• the files relevant to the standard are organised so that the assessment task and work for each of the 
students is readily identifiable by the moderator.  

• the share rights are set so the moderator can directly access the materials. For example:  

o Google Drive: “Anyone with the link”. 

 

Submit files stored on YouTube 

In this situation: 

• provide a URL for each student (by pasting into a document) 

• if all the URLs are in a single document then clearly identify each link, and upload the document, or  

• you can upload a separate document for each student, or 

Don’t forget to upload your assessment task/link when preparing your submission. 
 

FILE SIZES AND TYPES 

 

Accepted File Sizes  

File sizes are limited by the External Moderation Application.  Large files, especially videos, may impact 
on your experience for reasons other than platform limitations.  

Our experience indicates that file sizes of up to 30MB will enable an acceptable experience of submitting 
files.  

If you get an “Oracle Internal Error” then the file size is too large.  
This is best resolved by uploading moderation materials to cloud storage and then save the share link 
(URL) in the submission as outlines above. 
If you get an error, you should also clear your browser cache, cookies and history. 

There are several reasons why smaller files are more manageable:  

• depending on where you are working from, large files typically take a long time to upload; the upload 
may fail if the digital moderation application times out (this is set to occur after 15 minutes if you do 
not confirm your intention to continue) 

• they may use more storage space in your school system than you intend 

• depending on where moderators are working from, large files typically take a long time to download 
and could also be subject to timeout. 

We are happy to discuss options for managing large files on a case-by-case basis. Please contact  
modsupport@nzqa.govt.nz or (04) 463-3240, to do this.     

 

mailto:modsupport@nzqa.govt.nz
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Accepted File types 

The following file types are accepted: 

Files types Preferred format Formats also accepted 

Documents pdf doc, docx, odt, xls, xlsx, csv, ods, ppt, pptx, odp 

Images insert into a pdf documents 

Audio mp3, wav wmz 

Multi-media/video mp4, avi, mov   

If you are using other formats, moderators may not be able to read your files. Please contact 
modsupport@nzqa.govt.nz or (04) 463-3240 to discuss options if you are using file types other than 

those mentioned.   

MANAGING VIDEO FILES 

Video files are best uploaded to cloud storage and the share link saved in the moderation submission with 

the share permissions set so that the moderator can directly access the materials for moderation.  

Files stored in the cloud should be clearly identified and all learner grades still need to be entered into the 

submission. 

To reduce file size 

Reduce the size of files by: 

• adjusting the recording settings on your video camera 

• converting the file to another file type 

Video cameras, by default, are usually set to ‘auto’. The settings for the recording size and the frame rate 
are likely to be high and this creates large files (>200MB). There are many YouTube videos and other 
online guides on how to adjust your camera settings to create smaller video files. 

 

Convert to an accepted format 

The accepted video file types are: mp4, avi or mov.   

There are numerous applications available to convert video files from one format to another. See the 
Useful Resources below.  Many applications also have an export function which allows you to export files 
in a common format. 

Converting to another format may also compress the file. 

 

Other Useful Resources 

The following links provide more information on managing file formats. 

 http://www.zamzar.com/fileformats/ 

This website categorises many different file formats for documents, images, music, and video files, 
among others. It also provides an online conversion facility. 

https://www.lifewire.com/guide-to-camcorder-video-file-formats-487992  

Provides a useful guide to camcorder video file formats.  

 

mailto:modsupport@nzqa.govt.nz
http://www.zamzar.com/fileformats/
https://www.lifewire.com/guide-to-camcorder-video-file-formats-487992

